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• What’s new in LTspice24

• LTspice Basics Refresher

• Using new features in LTspice
• String parameters
• savestate  & loadstate
• Hierarchical Symbol Libraries
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• Convergence and simulation speed 

• Frequency Response Analysis (FRA)
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What’s new in 
LTspice24



LTspice 24: Faster Simulations
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Sim Time
(LTspice 17.1)

►Improved simulation speed
 Benchmarked ~200 popular MMP examples
 ADI-standard Dell i7 Precision 5550 laptop

►Improved run-to-run consistency
►Changed default trtol to 2 for 

further improved performance



DPI awareness improves UI scaling on high-res monitors, avoiding too-smalls and jaggies

LTspice 24 UI: Refresh Overall Look and Feel

Bigger, bolder status bar

Updated icons take advantage of DPI awareness

New Default Background

Updated cursors for clearer functionality 
and visibility on dark backgrounds 

Before After



►Customization-safe

►Return to old shortcuts via

New Keyboard Shortcuts and Dynamic Cheat Sheet

New Non-Modal, Floating Cheat 
Sheet Available from Help Menu



Yes, you can go back to the old toolbar!!



FRA Upgrades
►4-terminal Frequency Response Analyzer Probe

 Enables Bode plots of any part the loop

 Simplifies analysis of µModules with integrated top feedback resistors; negative outputs; 
and current feedback

►Phase changed to represent phase margin (phase +180°)

►Smooth stimuli transitions between frequencies

 Faster settling / improved accuracy



►No more “standard” library merge conflicts

 Standard discrete component libraries are simply overwritten when updated…

►Do not edit ADI-installed files in %localappdata%\LTspice

 Prompts discourage users from saving in AppData

 To add third-party symbols, libraries, and sub-circuits, place files in Documents\LTspice (directory 
configurable in Settings) 

 Files only; this is not recursive — does not support directory hierarchy.

 Hierarchical directories and files with unique names may be added to %localappdata%\LTspice

►Optional user-defined libraries (user.dio, mos, cap, ind, bjt, etc.) 

 May be added to define custom discrete devices in selection dialogs and simulations

 Place in Documents\LTspice by default (configurable in Settings)

Component Libraries and AppData



Documents

LTspice
(Location Configurable)

user.dio
user.mos
plot.defs
symbols
etc.

Third-Party
Preferred Placement
No Directory 
Hierarchy

[User]

AppData/Local/LTspice/Lib/cmp/

standard.dio
standard.mos
etc.

(Optional Third-Party 
Directory Structure)
Not advised unless 
directory hierarchy is 
required…

Directory Hierarchy Allowed
Unique File Names Required 

Component Libraries and AppData (Cont.)
LTspice Installs/Overwrites Files Here User Files Should be Placed Here



►Move plot panes up & down

►Add plot panes above or below

►Menu items and shortcuts to add/clear cursors, ESC key 
clears cursors

►Arrow keys to pan up, down, left and right

►Enable drag traces between panes during simulation

►Enable zooming while plotting

Waveform Viewer: Functionality Improvements



►New Configure Analysis        Toolbar Button and Shortcut (“A”)

► Improved Configure Analysis Dialog Functionality

 Captures all simulation commands on the schematic, including comments

 Populates tabs accordingly

 Automatically comment/uncomment schematic text

►Shift + Left-Click toggles text between directive and comment

Simulation Control



Improved Dialogs

► Better Component Selection
 Cleaner, more efficient layout
 Improved search in dialog
 Quick links to analog.com

► New: Symbol Parameter Editor



LTspice Basics

Black text = SPICE Directive = Active Simulation Control

Blue text = Inactive Comment

Shift + Left-Click to toggle
directive • comment  

For .ac: 1V AC Voltage source
For .tran: PWL step 0V1V at time 1µs, rise time 1ns

{parameterized capacitor value}

Right-click > Notes & Annot…> Annotate Steps

Simulation is controlled by text on the schematic Press ► to run simulation
Click on node to plot

Right-click directives and components to bring up helper dialog



Power Summit 2025

LTspice Basics – Identifying Traces in a Parameter Sweep



Example: Stepping intrinsic MOSFET .models

String Parameters (LTspice 24.1+)

.param MOSMODEL=select(n,”IRLR2908”,”FDB33N25”,”FDMC3612”)

.step param n list 0 1 2

n .model
0 IRLR2908

1 FDB33N25

2 FDMC3612



Example: Stepping .subckt models

String Parameters (LTspice 24.1+)

Important: 
• The list of signals saved in the raw file must match among all steps

• If subckt models have different structures, use .save to limit saved signals

• Ctrl+Right-click on Q1 nmos symbol to set prefix to “X” for subckt



https://www.analog.com/en/resources/technical-articles/ltspice-how-to-import-third-party-models.html

Importing Third Party Spice Models



Power Summit 2025

• Improved convergence

• Loadstate, savestate, and convergence report are available in .tran/.fra configuration dialog
• No longer require separate directives

• Alleviate hierarchy pain points
• Auto-generated symbols from .subckt no longer include directory path in ModelFile attribute (improves portability)

• Symbols that have simulation library file dependencies are indicated in netlist comments (easier debugging)

• Generate Subckt Netlist from a schematic (faster modeling)

• Optionally use a symbol to define the port order

• Add unicode support for file paths in settings

• Left-click any unconnected pin to start a wire in a schematic

• Improve display of recent files in File menu
• Show full path in status bar when hovered

©2025 Analog Devices, Inc. All Rights Reserved. 19

Coming in LTspice 26



POWER SUMMIT 2025

About the .savestate & .loadstate directives

• Capture the complete simulation state:

•  .savestate <statefilename> [time=<value>]

•  If no time is specified, the state is captured at the end of the simulation

• Reload the state:

•  .loadstate <statefilename> [reset]

• Simulation time jumps to the saved point, or can be reset to zero

• Components cannot be added, removed, or rewired

• Component values can be changed and LTspice will attempt to make it work

• Supports .tran and .fra

Analog Devices Confidential Information—Not for External Distribution. ©2024 Analog Devices, Inc. All Rights Reserved.20

Save and Load Transient Simulation State



POWER SUMMIT 2025

Example: Transient response with varying compensation cap values

©2025 Analog Devices, Inc. All Rights Reserved. 21

Save and Load Transient Simulation State



POWER SUMMIT 2025

Example: Transient response with varying compensation cap values

©2025 Analog Devices, Inc. All Rights Reserved. 22

Save and Load Transient Simulation State

Initial sim for .savestate after soft-start
Can optionally be stopped manually

Subsequent sim uses .loadstate to skip 
soft-start, with .step directive to vary pCTH
Clock time reduced by ~9 minutes

Right-click 
     > Notes and Annotations
          > Annotate Steps



Example: Use a custom res symbol that indicates current flow direction

Set Path to Symbols in Settings
The replacement symbol must exist at the 
root of a defined path

Overriding an Intrinsic Symbol

Do not place or edit files in %LOCALAPPDATA%\LTspice

Symbol Priority

1 Schematic Directory

2 Settings > User Files

3 Settings > Search Paths > Symbol Directories

4 ADI Library

Custom
Resistor



Common Problems 
& Solutions



Power Summit 2025

Simulation stops with an error
• Failure to find initial operating point

• Time step too small

• Singular matrix

Simulation runs extremely slowly
• Small time steps / slow transient simulation speed

• Very slow Pseudo Transient while finding initial operation point

It is common for a borderline circuit to converge or fail due to a minor and/or unrelated change.

©2025 Analog Devices, Inc. All Rights Reserved. 25

Convergence Problems — Symptoms



Power Summit 2025Analog Devices Confidential Information—Not for External Distribution. ©2025 Analog Devices, Inc. All Rights Reserved.26

Nonlinear Elements

𝐼𝐼𝐷𝐷 𝑉𝑉𝐷𝐷 = 𝐼𝐼𝑆𝑆 exp
𝑉𝑉𝐷𝐷
𝑉𝑉𝑇𝑇

− 1

linearized:

𝑉𝑉𝐷𝐷

𝐼𝐼𝐷𝐷

𝑉𝑉𝐾𝐾

𝐼𝐼𝐷𝐷 𝑉𝑉𝐾𝐾 slope: 𝑔𝑔𝐸𝐸𝐸𝐸 = �𝜕𝜕𝐼𝐼𝐷𝐷 𝑉𝑉𝐷𝐷
𝜕𝜕𝑉𝑉𝐷𝐷 𝑉𝑉𝐾𝐾

𝐼𝐼𝐸𝐸𝐸𝐸𝐼𝐼𝐷𝐷 𝑉𝑉𝐷𝐷 = 𝑔𝑔𝐸𝐸𝐸𝐸 × 𝑉𝑉𝐷𝐷 + 𝐼𝐼𝐸𝐸𝐸𝐸

Also used for .ac + .noise



Power Summit 2025

𝑉𝑉𝑁𝑁𝑁𝑁𝑁𝑁 − 𝑉𝑉𝑂𝑂𝑂𝑂𝑂𝑂 ≤ RELTOL × max 𝑉𝑉𝑂𝑂𝑂𝑂𝑂𝑂 , 𝑉𝑉𝑁𝑁𝑁𝑁𝑁𝑁 + �ABSTOL
VOLTOL

Close Enough?

Analog Devices Confidential Information—Not for External Distribution. ©2024 Analog Devices, Inc. All Rights Reserved.27

Newton Iteration

Evaluate Models, Linearize

Solve System Of Linear 
Equations

Converged?

Start

Success

Increase Time Step

No

Yes

𝑉𝑉1
𝑉𝑉2
⋮
𝑉𝑉𝑁𝑁

𝐼𝐼1
𝐼𝐼2
⋮
𝐼𝐼𝑁𝑁

𝐼𝐼1
𝐼𝐼2
⋮
𝐼𝐼𝑁𝑁

𝑉𝑉1
𝑉𝑉2
⋮
𝑉𝑉𝑁𝑁

𝐺𝐺𝜁𝜁 ⋯ ⋯ 0
⋮ ⋱ 𝐺𝐺𝜉𝜉
⋮ ⋱
0 1

𝐺𝐺𝜁𝜁 ⋯ ⋯ 0
⋮ ⋱ 𝐺𝐺𝜉𝜉
⋮ ⋱
0 1

Too Many
Times?

No

Failure

Try Decreased
Time Step

Yes



Power Summit 2025

• Discontinuities in component I-V curve

• Instantaneous changes

• Discontinuities in first derivative of component behavior

• Non-physical extremely high-impedance nodes (e.g. nodes with zero capacitance)

• Non-physical immediate local feedback

The preferred solution is always to fix the problematic circuitry.

Sometimes the problem may be in circuitry you can’t change (such as an encrypted model) …

… but there are some things that may still help.

©2025 Analog Devices, Inc. All Rights Reserved. 28

Common Sources of Convergence Problems



Power Summit 2025

Add .options debugtran to the schematic (new in LTspice 24.1)
• This adds a report to the log file
 Device Convergence Difficulty Score:

m5:gcapgd : 55.276382
m3:gcapgd : 54.522613
…
Node Convergence Difficulty Score:

 s3#current  : 76.884422
 s4#current  : 61.557789
 …
• Debugtran slows down the simulation

• Scores below 1 are usually negligible

• Scores above ~50 are a sure sign of a problem 

©2025 Analog Devices, Inc. All Rights Reserved. 29

Improve Convergence — Debug the Circuit



Power Summit 2025

If you can change the problematic circuitry, here are some things to try:

• Add capacitance, especially for high impedance nodes. Even 1e-15 or 1e-18 can help.

• Avoid discontinuities
• For ideal diodes, add (or increase) the epsilon parameter. Increase series resistance ron.

• Define trise for all logic gates (as large as possible).

• Avoid extreme non-physical values

• For example, don’t set emission coefficient n=0.001 for a silicon diode (should be in the range 0.5 ~ 2)

• Avoid instantaneous or extremely tight feedback
• For example, don’t use a behavioral current source to model a capacitor, don’t tie logic gate output back to its input

• Add series resistance to signal voltage sources using the rser parameter
• Also add a parallel capacitance using cpar

• Not recommended for power supply input sources

• Not recommended if current monitoring is important

©2025 Analog Devices, Inc. All Rights Reserved. 30

Improve Convergence — Fix the Circuit



Power Summit 2025

Increasing values compromises accuracy for the sake of convergence.
• Add startup keyword to .tran directive. Ramps top-level independent sources up from zero over first 20µs

• .options solver=alt : Use alternate solver. Higher precision, slower.  
Not available for ARM processors. Impractical for switching regulators due to slow speed. Generally, not more accurate.

• Add .nodeset directive to suggest initial operating points

• .options abstol=1e-10 : Increase absolute current convergence tolerance.
Default=1e-12, try values from 1e-11 to 1e-9.

• .options gshunt=1e-15 : Add a conductor from every node to ground, including internal subcircuits.
Default=0, try values from 1e-21 to 1e-9.

• .options reltol=0.005 : Increase relative convergence tolerance.
Default=0.001, try values from 0.002 to 0.05.

• .options gmin=1e-10 : Add a conductor in parallel with all PN diodes.
Default=1e-12, try values from 1e-21 to 1e-9.

  ©2025 Analog Devices, Inc. All Rights Reserved. 31

Improve DC Operating Point Convergence — Simulator



Power Summit 2025

With the exception of itl4 increasing values compromises accuracy.
• .options solver=alt : Use alternate solver.  Higher precision, slower.

Not available for ARM processors. Impractical for switching regulators due to slow speed. Generally, not more accurate.

• .options method=gear : Use Gear integration. Larger truncation error, tends to dampen oscillations, usually slower.

• .options itl4=50 : Transient iteration limit. Default=10, try values from 20 to 500. This only works properly in version 
24.1 and beyond. No accuracy penalty, but may slow down simulations.

• .options maxstep=1n : Maximum time step. Can also set this value in .tran directive. Default=tstop/1024.

• .options cshunt=1e-15 : Add a capacitor from every node to ground, including internal subcircuits.
Default=0, try values from 1e-21 to 1e-12.

• .options abstol=1e-10 : Absolute current convergence tolerance. Default=1e-12, try values from 1e-11 to 1e-9.

• .options gshunt=1e-15 : Add a conductor from every node to ground, including internal subcircuits.
Default=0, try values from 1e-21 to 1e-9.

• .options reltol=0.005 : Relative convergence tolerance. Default=0.001, try values from 0.002 to 0.05.

• .options gmin=1e-12 : Add a conductor in parallel with all PN diodes. Default=0, try values from 1e-21 to 1e-9.

• Use .savestate and .loadstate to temporarily modify tolerances for only a portion of a sim.

©2025 Analog Devices, Inc. All Rights Reserved. 32

Improve Transient Convergence — Simulator



Frequency Response Analysis (FRA)

𝑢𝑢𝑜𝑜 = −𝑇𝑇𝑢𝑢𝑤𝑤

+
−

𝑢𝑢𝑖𝑖 = 0 𝑢𝑢𝑜𝑜

𝑇𝑇
𝑢𝑢𝑤𝑤

𝛴𝛴 𝐴𝐴

𝐾𝐾

FRA

time frequency

► Perturbation is measured at FRA nodes
► Bode plot is extracted by Fourier analysis

► Transient Simulation
► The FRA component injects sinusoidal stimulus

see LTspice 24 and FRA How-To Webinar

https://ez.analog.com/webinar/c/e/766
https://ez.analog.com/webinar/c/e/766
https://ez.analog.com/webinar/c/e/766


analog.com

Generating SMPS 
Bode Plots in LTspice

https://www.analog.com/en/index.html
https://www.analog.com/en/index.html
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Bode Plots in LTspice



©2025 Analog Devices, Inc. All Rights Reserved. 

Frequency Response Analysis (FRA) Components in LTspice

FRA Device FRA Probe



Power Summit 2025

How to use the 
Frequency 
Response Analyzer 
Tool



POWER SUMMIT 2025

How To FRA

©2025 Analog Devices, Inc. All Rights Reserved. 

Place FRA Device

Configure FRA Simulate

Iterate



POWER SUMMIT 2025

What does the FRA Device do?

©2025 Analog Devices, Inc. All Rights Reserved. 

• Transient Simulation

• The FRA component injects sinusoidal stimulus

𝑢𝑢𝑜𝑜 = −𝑇𝑇𝑢𝑢𝑤𝑤

+
−

𝑢𝑢𝑖𝑖 = 0 𝑢𝑢𝑜𝑜

𝑇𝑇
𝑢𝑢𝑤𝑤

𝛴𝛴 𝐴𝐴

𝐾𝐾

FRA

Time Frequency

• Perturbation is measured at FRA nodes
• Bode plot is extracted by Fourier analysis



For many circuits, FRA Device is all that is needed

©2025 Analog Devices, Inc. All Rights Reserved. 

Typical Buck Example – including FRA Device



POWER SUMMIT 2025

What does the FRA Probe do?

©2025 Analog Devices, Inc. All Rights Reserved. 

FRA Probe used along with FRA 
Stimulus
• Enables Bode Plots of any 

portion of the loop

• Enables analysis of uModules, 
Inverting Outputs, Current 
Feedback topologies

Inverting Output Example – requires FRA Probe



µModules with integrated top feedback resistors

©2025 Analog Devices, Inc. All Rights Reserved. 

What does the FRA Probe do?

Negative Outputs

Current Feedback

These examples are in 
Open Examples -> Educational -> FRA



©2025 Analog Devices, Inc. All Rights Reserved. 

Functional FRA “Equivalencies” 



FRA Settings 
Overview



How To FRA

©2025 Analog Devices, Inc. All Rights Reserved. 

Place FRA Device

Configure FRA Simulate

Iterate



FRA Device Settings: Overview

©2025 Analog Devices, Inc. All Rights Reserved. 

Indicates simulated time based on settings above

Bode Plot of Gain or Output Impedance Sweep

Set the frequencies applied in the analysis

Set stimulus amplitude as a function of frequency

Set the timing of analysis and stimulus transitions

1k

500k

10k

6k

100m

10m

50k

500k

100u

100u

50u

1k 3 50k 1

5.52461m sec



©2025 Analog Devices, Inc. All Rights Reserved. 

2k

32k

100m

25m

4k

16k

250u

50u

100u

# of Frequencies
Specified in octaves so 
LTspice can apply 
simultaneous harmonics to 
speed up the simulation

Lowest Frequency
Highest Frequency 

1.29781m sec

FRA Device Settings: Required Frequency Settings

Example with 3 frequency points



©2025 Analog Devices, Inc. All Rights Reserved. 

50m

250u

50u

100u

Limit resolution at low frequency (Fcoarse)
LTspice applies just one point per octave below 
this frequency, to speed up simulations.  
Recommend 2x~10x Fstart.

2k

32k

6k

50k

2

Specify individual frequencies
To be applied in addition to the 
sweep specified above

1.29781m sec

FRA Device Settings: Optional Frequency Settings

Increase Resolution
Reduce Low Freqs
Specific Freqs



©2025 Analog Devices, Inc. All Rights Reserved. 

50m

250u

50u

100u

3 harmonics

1 harmonic

2k

32k

6k

50k

1, 2, and 3

2 harmonics

1.29781m sec

FRA Device Settings: Simultaneous Harmonics
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2k

32k

Signal needs to be large enough to 
resolve when divided by gain, yet 
small enough to avoid non-linear 
operation.

100m

25m

4k

16k

1.29781m sec

FRA Device Settings: Stimulus Amplitude
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2k

32k

Frequency Corners

Amplitude at Low Freqs
Amplitude at High Freqs

100m

25m

4k

16k

1.29781m sec

FRA Device Settings: Stimulus Amplitude
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2k

32k

100m

25m

4k

16k

Averaging (Tavgmin)
Must be sufficient to average out 
switching noise
(100 ÷ fSW is a good starting point)

Settling (Tsettle)
Must be sufficient to allow system to 
adjust to new stimulus pattern, generally 
at least 2 ÷ f0dB

Start Analysis at Time Delay
Must be long enough to allow 
circuit to reach steady-state

250u

50u

100u

1.29781m sec

FRA Device Settings: General



FRA Device Settings: General

©2025 Analog Devices, Inc. All Rights Reserved. 

2k

32k

100m

25m

4k

16k

250u

50u

100u

1.29781m sec

Inspect the resulting waveform 
in the transient simulation, and 
adjust these values accordingly



Completed in 25 secondsCompleted in 75 seconds

©2025 Analog Devices, Inc. All Rights Reserved. 

Presto!



Power Summit 2025

Config Wizard

©2025 Analog Devices, Inc. All Rights Reserved. 



FRA Device Settings: Configuration Wizard

©2025 Analog Devices, Inc. All Rights Reserved. 

The configuration wizard is used to quickly setup a FRA simulation  

Only three things to enter
• Switching frequency
• Approximate Bandwidth
• Output voltage



POWER SUMMIT 2025

FRA Device Settings: Configuration Wizard Results

©2025 Analog Devices, Inc. All Rights Reserved. 
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Power Supply 
Design using 
LTpowerCAD

https://www.analog.com/en/index.html
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Homepage



Product Selection Page

©2025 Analog Devices, Inc. All Rights Reserved. 60

Monolithic: Top and Bottom MOSFET are integrated in the part.
uModule: Top and Bottom MOSFET, inductor, and CIN/COUT are integrated.



©2025 Analog Devices, Inc. All Rights Reserved. 61

LTpowerCAD Power Stage Design Overview
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Loss Estimate & Break Down - Controller



Power Summit 2025©2025 Analog Devices, Inc. All Rights Reserved. 63

LTpowerCAD: Power Supply Design in 5 Easy Steps

Free download @ www.analog.com/LTpowerCAD

Product
Selection 

Schematic
(warnings, suggest)

Optimize 
Efficiency

Optimize 
Transient, Loop

Design 
Summary, Cost

http://www.analog.com/LTpowerCAD
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LTpowerCAD Loop Comp & Load Transient Overview



Current Mode DC/DC Converter and its Loop Gain

©2024 Analog Devices, Inc. All Rights Reserved. 65

R1

R2

C1

C2

Kref(s)
R-Divider

Vin

L

C

rc

R

Vo

PWM
d vo

LTC385x

iL feedback

Ki

Power Stage
 Gcv(s)

Comparator
gm

Cth

Rth

CthpCompensation
Network

Vref

igm vfbITH

Error 
Amplifier

A(s)

Current
Loop

Voltage
Loop

𝑽𝑽𝑰𝑰𝑰𝑰𝑰𝑰



POWER SUMMIT 2025

Buck Regulator: Design of Compensation Network 

©2025 Analog Devices, Inc. All Rights Reserved. 66

► High loop DC Gain (by default).

 Target #1) Fast Transient Response. (High BW)
→ Loop BW = 10%~ 20% fSW

Target #2) Stability. (across operating range)

→ PM >45 degree. (>60 degree preferred.)

→ GM < -10dB

 Target #3) Attenuate switching noises.
→ Gain @ fSW/2 < -8dB.  

 
Component Value Units

RTH 6.81 kΩ

CTH 2700 pF

CTHP 110 pF

CFF none pF

Initial values for LT8642S example
Fsw = 1MHz
Inductor = XEL4030-201MEB

Target #4) Meet transient Vpkpk spec.
→ ∆VOUT < ±3%.  

 

BW 19.95 kHz

PM 76.16°

GM -33.44 dB

Gain at 
½ Fsw

-33.44 dB

∆VOUT +/- 6.04%
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• Higher RTH increases gain between 
Fz1 and Fp2 

• Reduces ∆VOUT during load 
transients

• Reduces phase margin at 
higher frequency

ITH

CTH

RTH CTHP

freq.

Gain

gm⋅RTH

fZ1

fP2

~1
𝑅𝑅𝑇𝑇𝑇𝑇 ∗ 𝐶𝐶𝑇𝑇𝑇𝑇

~1
𝑅𝑅𝑇𝑇𝑇𝑇 ∗ 𝐶𝐶𝑇𝑇𝑇𝑇𝑇𝑇

Step 1: Set Loop Gain & Load Transient RTH = 6.81K

RTH = 30.1K
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Step 1: Set Loop Gain & Load Transient

Rth = 6.81K to 30.1K
CTH = 2700pF and CTHP = 110pF

Stability 
Metric

RTH = 
6.81kΩ

RTH = 
10kΩ

RTH = 
15kΩ

RTH = 
20kΩ

RTH = 
24.9kΩ

RTH = 
30.1kΩ

RTH = 
35.7kΩ

Effects of 
increasing Rth

Bandwidth 
(kHz)

19.95 28.18 39.81 50.12 50.12 56.23 56.23 Increases

Phase Margin 
(Deg)

76.16 78.57 71.5 61.22 56.53 48.7 44.8 Decreases Margin

Gain @ fSW/2 
(dB)

-33.46 -33.08 -32.88 -32.81 -32.78 -32.76 -32.74 Decreases Margin

Gain Margin 
(dB)

-33.46 -31.05 -28.91 -28.8 -26.92 -26.88 -26.86 Decreases Margin

∆VOUT (%) 7.01 5.86 4.88 4.46 4.28 4.18 4.14 Improves

 PM > 60° ∆ VOUT < ±3%  GM < -10dB  Gain @ fSW/2 < -8dB

Rth=6.81K to 30.1K

 Loop BW = 10%~ 20% fSW
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Step 2: HF Gain Attenuation (CTHP)

ITH

CTH

RTH CTHP

SW

• Higher CTHP reduces HF gain, improve HF noise immunity
• Lower CTHP may improve transient ∆VOUT

• fP2 moves to a higher frequency and will affect PM and GM

freq.

Gain

fP2

~1
𝑅𝑅𝑇𝑇𝑇𝑇 ∗ 𝐶𝐶𝑇𝑇𝑇𝑇𝑇𝑇

CTHP = 110pF

CTHP = 4.7pF
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Step 2: HF Gain Attenuation (CTHP) cont.

Stability 
Metric

CTHP = 
110pF

CTHP = 
100pF

CTHP = 
47pF

CTHP = 
22pF

CTHP = 
10pF

CTHP = 
4.7pF

Effects decreasing CTHP

Bandwidth 
(kHz)

56.3 56.23 70.79 79.43 79.43 89.13 Increases

Phase Margin 
(Deg)

48.7 51.22 63.3 74.64 82.87 85.69 Increases Margin at higher 
bandwidth

Gain @ 
fSW/2 (dB)

-32.76 -31.98 -26.07 -20.99 -17.3 -15.42 Decreases Margin

Gain Margin 
(dB)

-26.88 -26.11 -24.01 -20.99 -19.31 -19.48 Decreases Margin

∆VOUT (%) 4.18 4.07 3.36 2.99 2.94 2.91 Improves

 GM < -10dB PM > 60°  Gain @ fSW/2 < -8dB ∆VOUT  < ±3%

CTHP: 110pF to 4.7pF
RTH = 30.1K and CTH = 2700pF

CTHP: 110pF to 4.7pF

 Loop BW = 10%~ 20% fSW
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Step 3: Adjust Settling Time 

• Lower CTH reduces settling time because of the High Gain in low frequency.
• Potentially reducing Phase Margin if BW is around Fz1

ITH

CTH

RTH CTHP

gm⋅RTH

fZ1

Gain

freq.

~1
𝑅𝑅𝑇𝑇𝑇𝑇 ∗ 𝐶𝐶𝑇𝑇𝑇𝑇

fP1

~1
𝑅𝑅𝑂𝑂 ∗ 𝐶𝐶𝑇𝑇𝑇𝑇

CTH = 2700pF

CTH = 100pF

fP2
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Step 3: Adjust Settling Time cont.

Stability 
Metric

CTH = 
2700pF

CTH = 
2200pF

CTH = 
1500pF

CTH = 
220pF

CTH = 
100pF

Effects decreasing CTHP

Bandwidth 
(kHz)

89.13 89.13 89.13 89.13 89.13 No Effect

Phase 
Margin (Deg)

85.69 85.45 84.83 73.9 60.79 Decreases

Gain @ 
fSW/2 (dB)

-15.42 -15.42 -15.43 -15.57 -15.75 Slight effect

Gain Margin 
(dB)

-19.48 -19.48 -19.49 -19.61 -19.76 Slight effect

∆VOUT (%) 2.91 2.85 2.81 2.49 2.33 Improves

CTH: 2700pF to 100pF
RTH = 30.1K and CTHP = 4.7pF

 GM < -10dB PM > 60°  Gain @ fSW/2 < -8dB ∆VOUT  < ±3%

CTH: 2700pF to 100pF

 Loop BW = 10%~ 20% fSW



Repeat Step 1 – 3 in any order depending on what is 
needed. 

• Need more phase in Low frequency? Increase CTH

• Need more phase in High Frequency? Decrease CTHP

• Need more Gain Margin? Increase CTHP or Decrease RTH

• Need more BW? Increase RTH or decrease CTHP

• It is an iterative process

• If you can’t get there you may need more cap
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Step 4 Optimize the best you can

*Bonus: Aim for the top of the “phase peak”
in phase plot for more robust design.
Increase RTH from 30.1K to 45.3K

BW 89.13 kHz

PM 60.79°

GM -15.75 dB

Gain at 
½ Fsw

-19.76 dB

∆VOUT +/- 2.91%

Comp Value
CTH 100pF

RTH 30.1K

CTHP 4.7pF
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Final Step: Confirm Design Targets

LTpowerCAD File:ADIPowerSeminar_LT8642S_RL1221_Feb2025

 Loop BW <= 10%~ 20% fSW  GM < -10dB PM > 60°  Gain @ fSW/2 < -8dB ∆VOUT  < ±3%

Comp Value
CTH 100pF

RTH 45.3K

CTHP 4.7pF

112KHz              2.23%  66.6 °    -16.05dB -14.1dB
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Final Step: Confirm Design Targets - Before/After
Design Targets 

• Loop BW = 10%~ 20% fSW

• PM >45 degree. (>60 degree preferred.)

• GM < -10dB

• Gain @ fSW/2 < -8dB

• ∆VOUT < ±3%

Before After

BW 19.95 kHz 112 kHz

PM 76.16° 66.60°

GM -33.44 dB -16.05 dB

Gain at 
½ Fsw

-33.44 dB -14.10 dB

∆VOUT +/- 6.04% +/- 2.23%



Stability Metric CFF = OPEN CFF = 22pF Effects decreasing CTHP

Bandwidth (kHz) 89.13 141.25 Increases

Phase Margin (Deg) 60.79 82.4 Increases Margin

Gain @ fSW/2 (dB) -15.75 -9.98 Decreases Margin

Gain Margin (dB) -19.76 -16.8 Decreases Margin

∆VOUT (%) 2.33 2.23 Improves
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Feedback Loop

 Loop BW <= 10%~ 20% fSW  GM < -10dB PM > 60°  Gain @ fSW/2 < -8dB ∆VOUT  < ±3%

Near 
FBW



1. Set Bandwidth and Transient Response
1. Adjust RTH (higher RTH increases BW, decreases PM)

2. Check for transient response target

2. Check for HF Attenuation
a) Adjust CTHP (higher CTHP improves noise immunity at the expense of BW)

3. Set Settling Time
1. Adjust CTH (lower CTH reduces settling time at the expense of  PM)

4. Optional: Feedforward Capacitor
1. Check if phase boost is needed by looking at the PM and transient response

5. Close the loop 
1. Go back to Step 1 and re-check BW and Transient Response
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Summary of Compensation Design

freq.

fp2

THPTH CR ⋅
1~fp1

oTH RC ⋅
1

fz1

THTH CR ⋅
1

RTH

fBW

to set BW to 
attenuate 
HF noise

to increase 
LF (DC) Gain

CTH

CTHP

Reduce settle 
time Reduce 

under/over-
shoot VPP



Application Note 149 is an excellent discussion of loop 
compensation theory 



Thank you!
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